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1. Getting Started 

1.1. Features of WarpLAB 
WarpLAB is a finite element (FE) post-processing application that is specially designed 
to post-process warping problems. Besides common features found in many other FE 
post-process applications, such as generating surface plots, isosurface plots, plane cuts, 
and many more, it also has a unique set of features to analyze the images that are required 
to run a warping problem. A short list of features supported in the current version: 
 

• Graphical User Interface (GUI) 
• Command Line Interface 
• Command Line Calculator 
• Diverse plotting modes for visualization 
• Image processing 
• Volume rendering 
• … 

 
The GUI of WarpLAB allows the user to interact with the FE model in an easy and 
intuitive manner. For the more advanced user WarpLAB also offers a command line 
alternative.  
 

1.2. Running WarpLAB 
WarpLAB runs on Windows XP, LINUX and Mac OSX. In order to run WarpLAB a 
memory size of at least 512 Mb is recommended. Some larger models might require even 
more memory. A processor of at least 1 GHz is also recommended. The computer’s 
graphics card must support OpenGL, since the application makes extensive use of this 3D 
library. 
 
Command Options 
When starting WarpLAB from the command line, some options can be given. The full 
syntax for the command is: 
 
>warplab [file.wpp] 
 
Where file.wpp is a WarpLAB project file (see section 1.3). If a filename is specified, the 
file will be loaded into the WarpLAB environment when WarpLAB executes. 
 
In order to use the help files from within WarpLAB for the LINUX and Mac version, you 
are required to manually set the path to the WarpLAB main directory in the .cshrc (c-
shell) configuration file. So, assuming that /home/user/warplab/ is the WarpLAB’s home 
directory, you’ll add the following line to the .cshrc file: 
 
setenv WARPLAB_HOME /home/user/warplab/ 
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1.3. The Project File 
In order to start a warping analysis, a project file needs to be created. The project file is a 
simple ASCII file that lists all information that WarpLAB needs to start the post 
processing. The project file can either be made by the user itself, or can be created 
automatically by WarpLAB by selecting the File/New menu (see 1.4. Creating a new 
project). The following is an example of a project file: 
 
 
 

# WarpLAB project file sample 
plotfile = n3plot 
template = temp.raw 
target = study.raw 
dimension = 64 64 8 
range = 0 0 0 9.35 9.35 7 

Box 1. An example of a project file. 
 

All lines beginning with a pound (#) symbol are comment lines. Next, the five basic 
“ingredients” for a warp project are defined.  
 
plotfile  = base name of the plot file family 
template  = filename of template image 
target  = filename of target image 
dimension   = image resolution in three dimension (nx. ny, nz) 
range   = geometrical range of image data (xmin, ymin, zmin, xmax, ymax, zmax) 
 
The lines can be placed in any order but all five fields must be present. In addition to 
these mandatory fields, a few optional fields can be given as well: 
 
title  = Title of project. This title will replace the title in the plot file. 
type = Type of image.  This specifies the type as an 8-bit or 16-bit image. If no 

image type is specified, it is assumed to be the 8-bit default type. 

1.4. Creating a New Project 
To create a new project, the user can create the project file itself, e.g. by using a word 
processor to write the ASCII file. However, WarpLAB can create the project file for you. 
If you select the File/New menu, a dialog box will show up in which the user can type in 
all the necessary information. After pressing “OK”, WarpLAB will create the project file 
with the name given by the user and automatically opens the project. 
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Figure 1. The New Project dialog box 

 
Figure 1 shows the New Project dialog box. Enter the required information to create the 
project file. The Project Name is the name that will be given to the project. WarpLAB 
will attach to this name the extension .wpp and create the file for you with the 
information provided. Plot base is the base name for the family of plot files. This is 
usually the name of the first plot file outputted by NIKE3D, e.g. n3plot. Template is the 
name of the template image file. Target is the name of the study image file. Image type is 
the type of file image, specified as 8 or 16 bits, 8-bits being the default image type. 
Dimensions are the dimensions of the image data. Note that it is assumed that both 
template and target have the same dimensions. Range is the geometrical range (in the 
same units as the model’s coordinates) of that image data. Note that at this point 
WarpLAB only supports 8-bit raw image data. 
 
After the user selects the OK button, the file will be created and saved to disk in the 
current working directory. Next, WarpLAB will attempt to read the file in and load the 
project’s data. Note that the project file will always be created, regardless of whether it 
can successfully be loaded. 
 

1.5. Opening an existing project 
To open an existing project, select the File/Open menu. This will display the Open File 
dialog box. Select the project file (extension *.wpp) and click on OK. The file will then 
be loaded into WarpLAB. 
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2. Tutorial 
This chapter describes some of the main features of WarpLAB by using a sample file that 
comes with the executable. The sample shows a part of the left ventricle of the heart that 
was warped from beginning to end of diastole.  
 
In this tutorial you will learn: 

• to open an existing project 
• position the model in the graphical view 
• change a few post-processing options 
• saving a screenshot of the display 

 

2.1. STEP 1: Opening the sample project file 
To open the sample project, just open the file sample.wpp as described in section 1.5. 
This should load the sample data into WarpLAB. After loading the display should look 
similar to figure 2. 
 

 
Figure 2. Screenshot of the sample project file. 

 
In the left view (the graphics view) you can see the FE model. The color display by 
default shows the current template values. In the upper-left corner, below the title of the 
project, you can see what is being displayed. In this case it will read the default value 
Template value. The vertical colored bar on the right of the graphics view shows the 
legend. 
On the right you can see two image views. By default the upper view will show the (un-
deformed) template image and the lower view the target image. You can use the slide bar 
located between the image views to scroll through the different images. Also note that the 
current slice is also displayed in the graphics view on the left.  
In the lower-left corner, below the graphics view, the time controller is displayed which 
allows you to move trough the different time steps of the FE analysis.  
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2.2. STEP 2: Setting some options that effect the display 
Moving to the last timestep. In this step we will change a few settings so we can display 
what we really want. The first thing we’ll do is go to the last timestep. This is done by 
selecting the far right button (>>) on the time controller. This will advance the solution to 
the last timestep. You can also push the next timestep button (>|) to advance one step at a 
time until you reach the final timestep. Still another way is, when positioned on the very 
first step, to push the previous timestep (|<) button which will loop the solution to the last 
step.  To continuously loop through each timestep, the play (>) button can be pushed.  
 
Positioning the model. The user can rotate the current view of the model by simply 
holding down the left mouse button while dragging the cursor over the graphics view. By 
click+dragging the right mouse button, the user can also zoom in or out. To move the 
model left, right, up or down the user needs to click+drag the middle mouse button. 
Now practice this and position the model so that you have a clear view of the inside of 
the model.  
 
Changing the surface expression. By default, when loading a project, WarpLAB will 
display the template value on the surface. To change this, open the post options dialog by 
selecting the Post/Options menu. You should see the Options dialog box, such as 
displayed in figure 3. 
 

 
Figure 3. The Post-options dialog box. 

 
To change the expression for the surface, select the drop-down box named Expression. 
Now select Von Mises Stress. Also, in this dialog box, unselect the Display image 
checkbox. This will remove the current image slice from the graphics view. After 
selecting OK, the graphics view will be updated in accordance with the new settings.  
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2.3. STEP 3: Saving a screenshot 
In this step we will save the current graphics view to file. To do that, select the File/Print 
menu. This will open the Save File dialog box. Enter the filename you wish to use (e.g. 
sample.tif) and press the OK button. WarpLAB by default saves files as TIFF files 
(extension .tif), but can also save bitmap files (extension .bmp). To save a file as a bitmap 
file, select Bitmap Files in the drop-down box, named Show.  
After selecting OK, the current graphics view will be saved to a file, which can then be 
opened and modified by any image processor that supports the provided file types. 
 
This completes our tutorial. The points to remember are: 

• Use File/Open to open an existing warping project file (*.wpp) 
• You can use the mouse to position the model by left or right click+dragging 
• The Post/Options menu shows a dialog box where you can change the post 

processing options 
• The File/Print menu you can use to save the current graphical view to an image 

file 
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3. The Environment 

3.1. The GUI 
WarpLAB comes with a Graphical User Interface (GUI) that allows an easy and intuitive 
way to interact with the FE model and image data. Figure 4 shows the GUI when the 
program starts and after the sample file is loaded. 
 

 
Figure 4. The GUI after the sample file has been loaded 

 
The GUI consists of several items. The Menu Bar at the top (also see section 3.2) allows 
access to the various WarpLAB options and settings. Located below the menu bar is the 
Tool Bar (see section 3.3). The Graphics View (GV) shows a 3D image of the FE model. 
On the right of the GV are displayed two Image Views that allows the user to look at two 
different images simultaneously (by default these are the template and target images). A 
drop-down box, located above each of the image views, allows the user to select what 
image data he would like to see. The Image Selector, located between the image views, is 
used to scroll trough the image data in the event that more then one image slice is present. 
In between the GV and the IV’s, a small vertical bar is located which can be 
click+dragged to rescale the view areas. At the bottom left, the Time Controller is used to 
select the timestep that is being displayed. To the right of the Time Controller, is the 
Command Line, this can be used as an alternative to invoke WarpLAB commands. The 
Command Bar lists several buttons with common commands. 

3.2. The Menu 
In this section we will give an overview of the different menu items that can be found in 
WarpLAB. The main menu bar, located at the top of the GUI window, consists of the 
following items: 

• File - file operations, such as opening a WPP (warp post-process) project 
• Edit - options that apply to the current selection, such as hiding, un-hiding, etc 
• Post - do some post-process operations and set the post-processing options 
• Image - provides options and operations to be done on the image data 
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• View - provides options to customize the Graphics View 
• Help - allows access to WarpLAB help and the About dialog box 

 
A more in-depth description of the different menu items follows. 

The File Menu 
The file menu gives access to file operations and has the following menu items: 

• New - Starts a new warping post-process project 
• Open - Opens a project file (*.wpp) 
• Project Info - Gives some information about the current model and project 
• Print - Prints the current view to a file 
• Export image data - Exports the various image data 
• Export Scene - Export the data of the current scene to file 
• Exit - Quits the application 

 

The Edit Menu 
The edit menu gives access to operations that apply on the current selection: 

• Hide Selected - hides the current selected elements 
• Hide Unselected - hides the non-selected elements 
• Invert Selection - inverts the current selection 
• Unhide All - Un-hides all the previously hidden elements 
• Select All - selects all visible elements (invisible elements remain unselected) 
• Clear Selection - Clears the current selection 

 
 

The Post Menu 
The post menu allows the user to do post-processing operations and also allows you to set 
many of the options that effect what is being displayed. 

• Options - Set many of the options that effect what is being displayed 
• Summary - Provides some 2D plots of several fields such as displacement, strain, 

stress, etc. 
• Plane Cut - Displays a plane cut view of the model. 
• Trackview - Shows a time history of selected nodes or elements 
• Material Manager - Displays the Material Manager 

 

The Image Menu 
The image menu, allows you to change the settings that effect the displaying of the 
images, as well as perform some image analyses. 

• Options - Set options that effect image display 
• Histogram - Shows histogram data for template and target 
• Invert - Inverts the image data 
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• Volume render - Show a volumetric rendering of the image data 
 

The View Menu 
The view menu allows the user to choose options that customize the display. 

• Settings - Set foreground and background colors and style 
 

The Help Menu 
The help menu allows access to the help features available in WarpLAB and access to the 
software version and developers information. 

• WarpLAB Help - Opens the Help window 
• About - Displays the about box 

 

3.3. The Toolbar 
The toolbar is located below the menu bar and allows quick access to several menu 
items: 
 

 Creates a new project. 

 Opens an existing project. 

 Saves a screenshot to file. 

 Switches to node-selection-mode. 

 Switches to element-selection-mode. 

 Displays the WarpLAB Help window. 

 Dropdown box allowing the user to select the current displayed 
expression. 

 

3.4. The Command Line 
The command line, located at the bottom of the screen, gives the user an alternative way 
to invoke WarpLAB commands. Most of the commands can be issued from here by just 
typing the name of the command. In addition, the command line can also be used as a 
simple calculator. 

Using the Command Line 
Commands can be entered on the command line by typing the command name, followed 
by the command arguments, if any. For example, the command to open a file is simply 
open, followed by the filename: 
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>open sample.wpp [enter] 
 
To repeat the last command, just type an exclamation mark (!). So, for example, the 
following two commands will advance the timestep twice: 
 
>next [enter] 
>! [enter] 
 
Help for a command is also available by preceding the command name by a question 
mark (?). For example, to find out what the title command does, type: 
 
>? title [enter] 
 
Note the space between ‘?’ and ‘title’.  
Appendix A gives a detailed description of all available commands. Some commands do 
not have a menu alternative and thus can only be invoked from the command line. 
 

The Command Line Calculator 
On the command line simple arithmetic expressions can be evaluated by first typing the 
equal sign (=), followed by the expression. So, for example the following command, 
 
>= 5.2+3*(4.1–3.6) [enter] 
 
will result in 6.7.  
The Calculator recognizes the basic arithmetic operators (+, -, *, /), the power operator 
(^), floating point representation (e.g. 3.1415) as well as exponential representation 
(1.03e2), parentheses, a set of predefined named constants, 
 
pi = 3.14159265 
e  = 2.71828182 
 
and a set of arithmetic functions: 
 
cos = cosine of argument 
sin = sine of argument 
tan = tangent of argument 
ln = natural logarithm of argument 
log = base 10 logarithm of argument 
sqrt = square root of argument 
 

3.5. The Command Bar 
Located below the Graphics View, the command bar gives access to several useful 
commands. By simply clicking on the button, the label of which contains the desired 
command, the command is executed. Most of these commands (e.g. mesh, image, title, 
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etc.) are toggle buttons, so clicking it once deactivates the option and by clicking it again, 
the option is reactivated. 
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4. Post Processing 

4.1. Setting Post Processing Options 
Most of WarpLAB’s settings that affect what is displayed in the Graphics View can be 
set by invoking the Options dialog box. This can be done by selecting the Post/Options 
menu, pressing the F2 shortcut or by typing options on the command line. Next, the Post 
Options dialog box will be displayed and looks like figure 5. 
 

 
Figure 5. The Post Options dialog 

 
The following settings can be set in the Post Options dialog box: 
 

• Display image: show the current image slice also in the GV. In the drop down 
box, the user can select which image to display (template or target). 

• Show bounding box: display a box that represents the geometrical range of the 
image data. 

• Show title: display the title in the GV. 
• Show legend: display the legend in the GV. By pushing the settings button next 

to it, additional parameters that affect the way the legend is displayed can be 
selected. 

• Render smooth: if selected, uses Gouraud shading to display the plots. If not, flat 
shading is used. 

• Surface plot: show a plot of the exterior surface of the model. The color of the 
model is based on the selected expression. Additional settings for this type of plot 
can be set by clicking the Settings button next to it. 

• Isosurface plot: shows an isosurface plot of the expression. Additional settings 
for this type of plot can be set by clicking the Settings button next to it. 
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• Slice plot: shows a slice plot of the expression. Additional settings for this type of 
plot can be set by clicking the Settings button next to it. 

• Expression: affects what is being evaluated and displayed as the texture on the 
mesh. (see Table 1 below for descriptions and corresponding commands using 
eval command). 

 
Expression Field Description Command 
Image:   
None Displays no texture none 
Template Displays template texture template 
Target Displays target texture target 
Difference Displays difference texture diff 
Displacement:   
X displacement Displays texture displacement in the x direction xdispl 
Y displacement Displays texture displacement in the y direction ydispl 
Z displacement Displays texture displacement in the z direction zdispl 
XY displacement Displays texture displacement as the xy shear  xydispl 
YZ displacement Displays texture displacement as the yz shear  yzdispl 
XZ displacement Displays texture displacement as the xz shear  xzdispl 
Total displacement Displays total texture displacement displ 
Strain:   
X strain Displays texture strain in the x direction xstrain 
Y strain Displays texture strain in the y direction ystrain 
Z strain Displays texture strain in the z direction zstrain 
XY strain Displays texture strain as the xy shear  xystrain 
YZ strain Displays texture strain as the yz shear  yzstrain 
XZ strain Displays texture strain as the xz shear  xzstrain 
Effective strain Displays effective stain of texture vmstrain 
Principle strain 1 Displays first principle strain component e1 
Principle strain 2 Displays second principle strain component e2 
Principle strain 3 Displays third principle strain component e3 
Prin dev strain 1 Displays first principle deviatoric strain component e1dev 
Prin dev strain 2 Displays second principle deviatoric strain component e2dev 
Prin dev strain 3 Displays third principle deviatoric strain component e3dev 
Max shear strain Displays texture strain as the maximum shear maxe 
Plastic strain Displays texture strain of plastic plast 
Stress:   
X stress Displays texture stress in the x direction xstress 
Y stress Displays texture stress in the y direction ystress 
Z stress Displays texture stress in the z direction zstress 
XY stress Displays texture stress as the xy shear  xystress 
YZ stress Displays texture stress as the yz shear  yzstress 
XZ stress Displays texture stress as the xz shear  xzsress 
Von Mises stress Displays texture as a Von Mises stress  vmstress 
Principle stress 1 Displays first principle stress component s1 
Principle stress 2 Displays second principle stress component s2 
Principle stress 3 Displays third principle stress component s3 
Prin dev stress 1 Displays first principle deviatoric stress component s1ev 
Prin dev stress 2 Displays second principle deviatoric stress component s2dev 
Prin dev stress 3 Displays third principle deviatoric stress component s3dev 
Max shear stress Displays texture stress as the maximum shear maxs 
Pressure stress Displays texture stress resulting from pressure press 

Table 1: Descriptions and commands of available expressions 
 

• Color map: selects the color map (Jet, Gray, Autumn, Red, etc.) that is used to 
color the mesh, based on the local values of the evaluated expression.  The 
following are the color map values and corresponding commands:  Jet=jet, 
Gray=gray, Autumn=autumn, Winter=winter, Spring=spring, Summer=summer, 
Red=red, Green=green, Blue=blue, Red-Black-Blue=rbb, Fire=fire. 
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• Color smoothing: If activated the colors are interpolated smoothly across the 
mesh. If not activated a discrete color map is used. 

• Element Subdivisions: select the level of element subdivision. When drawing the 
mesh in the Graphics View the elements are divided in sub-elements to improve 
the visual appearance of the mesh. Note that this has no effect on Tet-meshes 
(Tetrahedral meshes). 

 
Most of the options can also be set by invoking commands on the command line. See 
appendix A for a complete overview of the available commands. 
 

4.2. Summary View 
The Summary View displays an overview of minimum, maximum, and average values of 
different expressions.  This summary of values can be calculated using only selected 
elements or nodes, or for the entire selection when no elements or nodes are selected.  It 
can be opened by selecting the Post/Summary menu or by typing summary on the 
command line. Figure 6 shows the Summary View window. 
 

 
Figure 6. Summary View 

 
To select the expression to display, click on the drop-down box in the upper left corner 
and select the desired expression. Each data point can be selected by clicking on it. The 
exact values will appear next to a selected data point. 
To save the summary data to file, click the Save button located at the bottom of the 
Summary View. This will open the File Save dialog box. After the user enters a filename, 
the data is saved to file as a simple ASCII file. 
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4.3. Trackview 
The Trackview can be used to show time history plots for individual elements or nodes. 
To display the trackview, select the Post/Trackview menu or type track on the 
command line. The Trackview should appear as in figure 7. 
 

 
Figure 7. Trackview 

 
The trackview displays the selected expression for the selected mesh items (see below on 
how to select mesh items). On the right the item numbers (preceded by an ‘E’ for 
‘element’ or ‘N’ for ‘node’) are shown in the same color as the corresponding curve. 
 

Selecting mesh items 
You can select both elements and nodes. Which item is selected is controlled by the two 
selection buttons in the Toolbar: 
 

 Switches to node-selection-mode. 

 Switches to element-selection-mode. 
 
To add an item to the current selection, just shift+click the node or element. When tags 
are enabled, a dot followed by the item’s number will appear next to the item. To enable 
the tags, type tags on the command line, or select the corresponding button in the 
command bar. To remove an item from the current selection, just ctrl+click the node or 
element. You can (de-) select multiple items at the same time by dragging the mouse 
cursor while holding down the shift or ctrl key and the left mouse button. A colored 
rectangle will appear indicating what elements or nodes will be selected. Note that only 
visible elements or nodes that fall inside this rectangle will be selected. This means that 
only elements or nodes on the surface of the mesh can be selected. 
 



 17

You can also use the command line to select items. To select for example element 1000, 
just type the following command on the command line: 
 
>selelem 1000 [enter] 
 
This will have the same effect as shift+clicking the element (if it is visible). However, by 
using the command line, you can also select non-visible elements.  
The command for selecting nodes is 
 
>selnode 2500 [enter] 
 
To clear the entire selection, you can either push the clear button in the Trackview dialog 
box (if it is opened) or you can use the command line by typing: 
 
>clrsel [enter] 
 
When no other windows are open (such as e.g. Trackview, etc.), pressing the ESC-key 
also clears the selection. Finally, you can select the Edit/Clear Selection menu to clear the 
entire selection too. 
 
Also note that the Edit menu lists several options to manipulate the current selection, 
such as hiding, un-hiding, inverting, etc. 
 

4.4. Making Plane Cuts 
The menu Post/Plane Cut opens the Plane Cut window. This window shows the 
intersection of a plane and the model. The intersecting plane is displayed in the Graphics 
View. The position of this plane can be controlled by sliding the scroll bar at the bottom 
of the Plane Cut window. The orientation (in x, y, z) is controlled by sliding the 
scrollbars at the top. This more accurately controls the plane normal. The roller on the 
right side of the window controls the rotation of the plane around its normal and can be 
used to position the plane cut in a more desired orientation.  
 
The color and expression used to display the plane cut are the same as in the Graphics 
View. In order to change them you need to change the expression and/or color map in the 
Post Options dialog box (see section 4.1). 
 
You can also look at local values by clicking on a specific point on the plane cut view. A 
cross mark with the local value will appear on the selected point. This is a useful way to 
inspect the local values. 
 
The Print button at the bottom of the Plane Cut window allows the user to save the 
current view to file.  
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Figure 8. The Plane cut view. Clicking the mesh allows you to inspect local values. 

 
 

4.5. The Material Manager 
The material manager controls the visual properties of the different materials in the FE 
model. It is opened by selecting Material Manager from the Post menu, typing mat on 
the command line, or by using the F3 shortcut. The Material Manager window is shown 
as figure 9. 
 

 
Figure 9. The Material Manager handles the appearance of the different materials. 

 
In the left pane a list of all the different materials in the FE model is visible. The colored 
square, preceding the material name, identifies the diffuse color of the material. The 
current material is highlighted with a light blue background and can be changed by 
clicking with the mouse on one of the other materials. 
The hide button hides the selected material and the unhide button un-hides it. 
The right pane shows the settings that can be altered for the selected material. The 
options are: 
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• Diffuse: sets the diffuse color of the material. By clicking on the colored button, 
the Color Selector dialog is opened and the color can be changed. Closing the 
Color Selector will automatically update the color in the Graphics view. Note that 
the diffuse color is only used when no expression is selected or when the material 
is disabled. 

• Ambient: sets the ambient color for the material. Click the colored button next to 
it to change the ambient color. 

• Specular: sets the specular color for the material. Click the colored button next to 
it to change the specular color. 

• Emission: sets the emission color for the material. Click the colored button next to 
it to change the emission color. 

• Mesh Color: sets the mesh color for the material. Click the colored button next to 
it to change the mesh color. 

• Shininess: sets the shininess value for the material. Slide the slide bar to change 
the shininess value. 

• Enable: If checked the material is enabled and the color of the material is 
determined by the local expression value. If unchecked the material will be 
disabled and displayed with its diffuse color. 

 
 

4.6. Displaying user data 
Besides displaying the expressions specified in the expression selector, the user can also 
display data that is imported from a file. In order to do this the user needs to use the 
userdata command. Which can load up to five different user data files. So, the following 
command  
 
userdata1 "Deviatoric xy stress" dev.txt 
 
will load the data in the file dev.txt into the first user data buffer and give it a description. 
This description will show up in the expression selector under the user menu and in the 
title on the graphics view. 

4.7. The View Settings 
The View Settings dialog box (fig. 10 below) controls the background color, background 
style and foreground colors. You can invoke it by selecting the View/Settings menu or by 
typing view on the command line. 
 
It allows you to select the following options: 

• Background color 1: set the first background color.  (The command line 
currently supports setting color to white, black, red, green, and blue). 

• Background color 2: set the second background color.  (The command line 
currently supports setting color to white, black, red, green, and blue). 

• Swap: swaps the first and second background color. 
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• Background style: set the style of the background.  The following are styles and 
corresponding commands:  Color 1=color1, Color 2=color2, Fade 
Horizontal=horz, Fade Vertical=vert, Fade Diagonally=diag. 

• Foreground color: sets the foreground color. That is the color of the title, the 
legend and the bounding box.  (The command line currently supports setting color 
to white, black, red, green, and blue). 

 

 
Figure 10. View Settings dialog box. 

 

4.8. Saving Graphics 
To save a screenshot of the current Graphics View, select the File/Print menu. This will 
save the current view to a file. When the menu item is selected, the File Save dialog box 
appears and the desired filename can be entered or selected. Images can be saved as 
Windows Bitmap or TIFF images. In either case a 24 bit, uncompressed image is saved. 
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5. Image Processing 

5.1. Setting Image Processing Settings 
The settings that affect the way the image data is displayed in the image views can be set 
in the Image Options dialog box. This dialog box can be accessed trough the 
Image/Options menu item. Figure 11 shows the Image Options dialog box. 
 

 
Figure 11. Image options dialog box 

 
The show geometry checkbox is used to show or hide the current geometry in the image 
views. The geometry displayed is similar to the plane cut feature and shows the contours 
of the intersection between the geometry and the image plane. 
The Image 1 (2) color map can be used to display the images with different color maps. 
 

5.2. Image Histograms 
The histogram of the template and target images can be inspected by selecting the 
Image/Histogram menu. The histogram of the template and target are displayed in 
different colors. By default the scale is linear, but a logarithmic scale can be used by 
checking the Log checkbox at the bottom of the dialog box. 
 

5.3. Image Inverting 
The image can be inverted by selecting the Image/Invert menu item.  The resulting image 
will have be a reversal of contrasting colors. 
 

5.4. Volume Rendering 
A volume rendering of the image data can be visualized by selecting the Image/Volume 
render menu item. A dialog will pop up that allows the user to set the parameters (figure 
12). 
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Figure 12. The Volume render dialog box. 

 
In the Image field you can select to volume render either the template or the target image. 
The curve displays the linear mapping from the image grayscale values to transparency 
levels. So, in the case displayed in figure 12, black pixels (grayscale 0) will be 
completely transparent, while white pixels (grayscale 255) will be opaque. The edit fields 
surrounding the curve view allow you to customize the mapping. You can manually type 
in the values or you can click+drag in the edit fields to change their value. The alpha 
scale bar sets the global transparency level of the volume render. The color bar at the 
bottom shows the color mapping from grayscale to color. Pushing the buttons at both 
ends of the color bar will popup a color selection dialog. 
The volume rendering is not updated until you push the Update button. To automatically 
update the volume rendering while you change the parameters you must the set the auto-
update option (i.e. push the button with the arrow, next to the Update button). 
 
WARNING! Volume rendering a 3D dataset is a computationally very intensive task. It 
is highly recommended to only use volume rendering if you have a graphics card that 
supports hardware acceleration. Also note that on most laptops graphics hardware 
acceleration is not activated when the laptop is running on batteries. 
 

5.5. Exporting Image data 
The image data displayed in the Image Views can be exported by selecting the 
File/Export Image data menu item. This is particularly interesting for exporting the 
deformed template or difference images since they are generated by WarpLAB. 
However, since the images can be rescaled on export, it is also a useful tool to rescale the 
template or target image data.  
The images are exported as 24 bit RAW images (in RGB colors). The images are 3D 
images and contain as many slices as the template (or target) data, but might have a 
different resolution. This resolution is displayed in the Export Image Data dialog box. In 
case the images depend on the deformation of the model (such as in the deformed 
template and difference images), only the images at the current timestep are exported. 
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APPENDIX A – Commands 
Here follows a list of all the commands recognized by WarpLAB. A command can have 
no arguments, optional arguments or mandatory arguments. The general syntax is: 
 
command [optional arg] <mandatory arg> [option A |option B], 
 
where command is the name of the command, [a] indicates optional arguments, <a> 
indicates mandatory arguments, [ a | b ] indicates a list of choices. 
 
! repeats the last command 
? <command> provides help on a command, where command is the name of the 
command. 
= <expression> invokes the command line calculator. 

FILE COMMANDS 
exit Exits the application. 
info Displays information about the current model and project. 
new Opens the File New dialog box. 
open [filename] If filename is present, opens the file, otherwise opens the 

File Open dialog box. 
print [filename] Prints the current view to a file with name filename. If 

filename is omitted, the File Save dialog is opened. 

 POST/IMAGE COMMANDS 
box [on|off] Shows (on) or hides (off) the bounding box in the Graphics 

View. 
color <colormap>  Sets the color map. Refer to section 4.1 for valid colormap 

commands. 
cut Displays the plane cut view. 
histo Shows the image histogram window. 
image [on|off] Shows (on) or hides (off) the image in the Graphics View. 
range [static|dynamic|user <min max>] Sets the range for the legend. 
legend [on|off] Shows (on) or hides (off) the legend in the Graphics View. 
mat Shows the material manager. 
mesh [on|off] Shows (on) or hides (off) the mesh. 
options Displays the post-options dialog box. 
smooth [on|off] Renders the model in smooth (on) or flat (off) shade. 
summary Displays the post-summary. 
title [on|off] Shows (on) or hides (off) the title in the Graphics View. 
track Displays the track view 
triad [on|off] Shows (on) or hides (off) the triad. 
userdata(n) <"description"> [filename] Loads user data from file. 
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TIME CONTROL COMMANDS 
anim [fps] Starts the animation, with optional framerate fps 
first Go to the first time step. 
last Go to the last time step. 
next Go to the next time step. 
prev Go to the previous time step. 
stop Stop the animation 
time <time> Go to time timestep, where time is a number between 1 

and the max numbers of timesteps. 

FIELD SELECT COMMANDS 
eval <expression> Evaluates the expression. Refer to Table 1 of section 4.1 

for valid expression commands. 

EDIT/SELECTION COMMANDS 
clrsel Clears the selection. 
hide Hides the current selection. 
selelem <elem id> Selects element with element id elem id. 
selnode <node id> Selects node with node id node id. 
tags [on|off] Shows (on) or hides (off) the selected item's tags. 

 

TRANSFORM COMMANDS 
back  Display back view. 
bottom Display bottom view. 
front  Display front view. 
left Display left view. 
right Display right view. 
pan <x> <y> Sets the panning coordinates (x, y) 
quat <x> <y> <z> <w>  Sets the orientation quaternion q(x,y,z,w) 
rotx <angle> Rotate angle degrees around the x-axis. 
roty <angle> Rotate angle degrees around the y-axis. 
rotz <angle> Rotate angle degrees around the z-axis. 
top Display top view. 
zoom <z> Sets the zooming coordinate (z) 

VIEW COMMANDS 
bg [color name| r g b] Set background color 1 either by name or RGB value (0-1).
bg1 [color name| r g b] Set background color 1 either by name or RGB value (0-1).
bg2 [color name| r g b] Set background 2 color either by name or RGB value (0-1).
bgstyle <style> Set the background fading style.  Refer to section 4.7 for 

valid style commands. 
fg [color name| r g b] Set foreground color either by name or RGB value (0-1). 
view Options the view settings dialog box. 
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HELP COMMANDS 
about Displays the about box. 
help Displays the WarpLAB help window. 
 


	WarpLAB
	USER’S MANUAL
	TABLE OF CONTENTS
	1. Getting Started
	1.1. Features of WarpLAB
	1.2. Running WarpLAB
	1.3. The Project File
	1.4. Creating a New Project
	1.5. Opening an existing project

	2. Tutorial
	2.1. STEP 1: Opening the sample project file
	2.2. STEP 2: Setting some options that effect the display
	2.3. STEP 3: Saving a screenshot

	3. The Environment
	3.1. The GUI
	3.2. The Menu
	The File Menu
	The Edit Menu
	The Post Menu
	The Image Menu
	The View Menu
	The Help Menu

	3.3. The Toolbar
	3.4. The Command Line
	Using the Command Line
	The Command Line Calculator

	3.5. The Command Bar

	4. Post Processing
	4.1. Setting Post Processing Options
	4.2. Summary View
	4.3. Trackview
	Selecting mesh items

	4.4. Making Plane Cuts
	4.5. The Material Manager
	4.6. Displaying user data
	4.7. The View Settings
	4.8. Saving Graphics

	5. Image Processing
	5.1. Setting Image Processing Settings
	5.2. Image Histograms
	5.3. Image Inverting
	5.4. Volume Rendering
	5.5. Exporting Image data

	APPENDIX A – Commands
	FILE COMMANDS
	POST/IMAGE COMMANDS
	TIME CONTROL COMMANDS
	FIELD SELECT COMMANDS
	EDIT/SELECTION COMMANDS
	TRANSFORM COMMANDS
	VIEW COMMANDS
	HELP COMMANDS


